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Introduction
�  Who Should Read This Guide

�  Related Publications

�  World Wide Web Information

�  Getting Help
.

Who Should Read This Guide
This guide is intended for administrators who are installing or configur-
ing TestPartner; it does not contain reference or usage information. You 
can find that information in the TestPartner Help.

Compuware assumes that you are familiar with basic Microsoft Windows 
navigation. If this is not the case, familiarize yourself with the documen-
tation for Microsoft Windows before reading this guide.

Related Publications
In addition to the TestPartner Installation and Configuration Guide, the 
TestPartner documentation set includes the Distributed License Manage-
ment Installation Guide, which contains instructions for licensing your 
QACenter product. Both installation guides are only available in PDF 
format.

You can view and print the installation guides from your QACenter 
installation media or from Compuware’s FrontLine customer support 
Web site at http://frontline.compuware.com

Because PDF is based on PostScript, a PostScript printer is the most 
reliable way to print the installation guides. In most cases, you can also 
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print PDF files to PCL printers. If you cannot print the PDF files to your 
printer, refer to Adobe’s Web site at http://www.adobe.com for trouble-
shooting information.

World Wide Web Information
To access Compuware Corporation’s site on the World Wide Web, point 
your browser at http://www.compuware.com. The Compuware site 
provides a variety of product and support information.

FrontLine Support Web Site: You can access online customer support for 
Compuware products via the FrontLine support Web site. FrontLine 
provides fast access to critical information about your QACenter product. 
You can read or download documentation, frequently asked questions, 
and product fixes, or e-mail your questions or comments. To access 
FrontLine, follow these steps:

1 Open a Web browser and go to: http://frontline.compuware.com 
The Welcome to FrontLine page appears.

2 On the right side of the page, enter your login ID and password and 
click the Login button. 

Note: If you are a first-time visitor, click the Register button to receive your 
free password to access FrontLine. After you complete the registra-
tion form, your login ID and password will be e-mailed to you and 
your account will be activated.

3 From the list in the center of the page, select a product and click the 
Go button. You will see the product’s FrontLine home page, where 
you can access documentation, technical information, fixes, and 
other support items.

Getting Help
At Compuware, we strive to make our products and documentation the 
best in the industry. Feedback from our customers helps us maintain our 
quality standards. If you need support services, please obtain the follow-
ing information before calling Compuware’s 24-hour product support 
hotline:

� The name, release (version), and build number of the QACenter prod-
uct. This information is displayed when you select the About com-
mand from your product’s Help menu. The name and release are also 
on the covers of the product documentation.
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� Installation information, including installed options, whether the 
product uses local or network databases, whether it is installed in the 
default directories, whether it is a standalone or network installation, 
and whether it is a client or server installation.

� Environment information, such as the operating system and release 
on which the product is installed, memory, hardware/network speci-
fications, and the names and releases of other applications that were 
running.

� The location of the problem in the QACenter product software, and 
the actions taken before the problem occurred.

� The exact product error message, if any.

� The exact application, licensing, or operating system error messages, 
if any.

� Your Compuware client, office, or site number, if available.

Compuware Customer support

Compuware Corporation 
One Campus Martius 
Detroit MI 48226-5099 
1-800-538-7822
 Introduction     7
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Chapter 1

Getting Started
� Overview of QACenter

� Installation Types

� Before Installation

Overview of QACenter
QACenter is a suite of automated software quality products for enterprise 
and e-business applications. QACenter offers a comprehensive solution 
for IT organizations concerned with assuring quality and performance, 
while keeping pace with faster development cycles. QACenter includes:

QADirector:  Coordinates the entire testing process by organizing, track-
ing, and executing automated and manual tests. QADirector integrates 
with Compuware’s testing, program analysis, defect tracking, and 
requirements management tools. 

The QADirector Test Management Server reads job submissions from the 
database, manages jobs, tracks available test execution machines, and 
manages the licenses for manual test Web execution. It also reports on 
the status of jobs in progress. 

The QADirector Test Execution Server is installed on the local machine. 
The Test Execution Server allows jobs to run on a computer, however you 
do not need a Test Execution Server to run jobs via QACenter Portal.

CARS Workbench: Provides a comprehensive reporting facility that is 
consistent among the QACenter point products. It enables users with 
various roles and responsibilities to create and view detail, summary, and 
cross-product reports. CARS Workbench ties together requirements 
planning, test planning, test execution, and defect tracking to provide 
users with a centralized view of application quality. It also integrates with 
Reconcile and QADirector and provides QADirector Web functionality.
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QAHiperstation+: Works with mainframe QAHiperstation to test host-
based applications directly from your Windows desktop. This integrated, 
workstation-based interface tool uses 32-bit code that provides improved 
performance and better stability on 32-bit Windows platforms.

QARun: Tests enterprise client/server applications. QARun creates and 
runs test scripts that support a wide variety of development tools and the 
diverse components of today's corporate environments. QARun couples 
advanced verification facilities with error-recovery mechanisms to 
reliably test local and remote applications. 

Reconcile: Helps create and control project requirements. It stores the 
project requirements in a relational database. You can view the require-
ments through Microsoft Word, a reporting view (grid), and the Web. 
Reconcile is fully integrated with QADirector and TrackRecord. Working 
together, these products help you manage project development from 
conception through delivery.

TestPartner: Tests Web- and Windows-based applications that use 
Microsoft technologies. TestPartner records user actions to quickly 
produce powerful visual tests. Each recorded visual test displays as a 
series of actions in clear, concise steps that can be easily understood by 
all testers, from novice to expert. You can record user sessions with the 
application, add validation functions, and replay the sessions later to 
ensure that the application works as expected. TestPartner supports 
testing of Java, Visual Basic, and Visual C++ applications; browser-based 
Web applications; and component-based applications, including GUI 
and non-GUI COM components on the client side or server side.

TrackRecord: Records and reports information about products being 
developed or supported. Information on team members, testers, sched-
ules, and defect reports is recorded in an object-oriented database; it can 
be retrieved using TrackRecord's query and reporting features.

Installation Types
Tip: An upgrade to a new 
release does not require 
you to uninstall the 
current release provided 
the current release is 
TestPartner 5.6 or later.

Before you begin, determine the type of installation you need to perform:

Initial Installation: An initial installation is the first-time installation of a 
product on your computer. For TestPartner installation instructions, see 
“Installing TestPartner” on page 16.

Modify: A modification of the product installation occurs when you add 
or remove one or more of a product’s components, but not all of them. 
10     TestPartner Installation and Configuration Guide



For TestPartner modification instructions, see “Modifying an Installa-
tion” on page 62.

Repair: A repair installation may be necessary due to a corruption of a 
program or the inadvertent deletion of the product. For TestPartner 
repair instructions, see “Repairing an Installation” on page 62.

Remove: A remove or uninstall removes all the components of a product. 
For TestPartner removal instructions, see “Removing a Product” on page 
62.

Before Installation 
Before installing any QACenter product, you should carefully review the 
following information:

System Requirements

Review the system requirements to ensure that you meet the prerequi-
sites for the successful installation and operation of the product. System 
requirements are also listed in the Release Notes.

Release Notes

Review the Release Notes for information about new features, technical 
notes, and known issues that may enhance or impact your product’s 
performance. Release Notes contain recent changes that may not be 
included in your QACenter product documentation. 

Release Notes can be viewed from the QACenter installation media or on 
FrontLine, Compuware’s product support web site. The Release Notes on 
FrontLine are periodically updated as new information becomes avail-
able.

To access the TestPartner Release Notes from the QACenter installation 
media:

1 From the QACenter installation media, access the TestPartner Release 
Notes. The Release Notes open in your default Web browser.

2 View the Release Notes or print the document.

3 After viewing or printing the Release Notes, close the document to 
return to the QACenter installation media.

To access the TestPartner Release Notes on FrontLine:
Chapter 1� Getting Started     11



1 Open a Web browser and go to: http://frontline.compuware.com 
The Welcome to FrontLine page appears.

2 On the right side of the page, enter your login ID and password and 
click the Login button. 

Note: If you are a first-time visitor, click the Register button to receive your 
free password to access FrontLine. After you complete the registra-
tion form, your login ID and password are e-mailed to you and your 
account is activated.

3 From the list in the center of the page, select TestPartner and click 
the Go button. TestPartner’s FrontLine home page appears.

4 On the left side of the TestPartner’s home page, select the Documen-
tation link. You will see the TestPartner documentation page, which 
includes links to Release Notes and other documentation types.

5 Click the HTML or PDF icons to view the desired documents.
12     TestPartner Installation and Configuration Guide
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Chapter 2

Installing TestPartner
� System Requirements

� Installing TestPartner

� Setting Up a SQL Server Database with TestPartner

� Setting Up an Oracle Database with TestPartner

� Setting Up SQL Server or Oracle for TestPartner Without a 
Domain

� Creating a Data Source Name

� Migrating TestPartner Objects from a Standard Character Set 
to UTF8 (for Unicode)

� Logging On and Starting TestPartner

System Requirements
TestPartner has the following minimum system requirements:

Hardware: � PC with a Pentium III processor or higher; minimum of 512 MB of 
RAM

� 300 MB of hard disk space on the system disk (the disk on which the 
operating system is installed), and an additional 220 MB when 
installing SQL Server 2005 Express as the default TestPartner database

� Optimized for 1024 x 768 or higher screen resolution 

Operating System: � Microsoft Windows Vista (32-bit)

� Microsoft Windows Server 2003 R2 Standard Edition (32-bit)
 13



� Microsoft Windows Server 2003 R2 Enterprise Edition (32-bit)

� Microsoft Windows Server 2003 Web Edition (32-bit)

� Microsoft Windows XP Professional SP2 (32-bit)

Browser: � Microsoft Internet Explorer 7.0

� Microsoft Internet Explorer 6.0 (SP2)

� Mozilla Firefox 2.0

Database: � Microsoft SQL Server 2005 SP1 & SP2; Prerequisites include MDAC 
2.8 (2.80.1022.3), .NET Framework 2.0, Windows Installer 3.1

� Microsoft SQL Server 2005 Express Edition SP2 (for up to 5 users); 
Prerequisites include MDAC 2.8 (2.80.1022.3), .NET Framework 2.0, 
Windows Installer 3.1

� SQL Server 2000 SP4; Prerequisites include MDAC 2.6 SP2 
(2.62.7400.1), .NET Framework 2.0, Windows Installer 3.1

� Microsoft Access 2000 (as a single-user database)

� Oracle 10.2, 10.1, 9.2 RDBMS database on Microsoft or Unix/Linux 
platforms

Other Software: � Microsoft Visual Basic for Applications 6.5 (6.5.1024, 6.5.1020), 
(VBA) 6.4 (6.4.9969, 6.4.9971, and 6.4.9972), 6.3 (6.0.9108), 6.2x 
(6.0.8967), or 6.2 (6.0.8714); TestPartner installs VBA 6.2 (6.0.8714) 

� Adobe Acrobat or Acrobat Reader to view the documentation pro-
vided in PDF format (the Acrobat Reader setup file is available from 
Adobe's Web site: www.adobe.com)

� Additional resources may be required for testing tools and the appli-
cation under test

Input Method Editor (IME) Support

TestPartner supports the following IMEs for the listed input systems.

Legend X = Supported
14     TestPartner Installation and Configuration Guide



Japanese Input 
System:

Korean Input 
System:

Simplified Chinese 
Input System:

Description File Name Windows 
2000

Windows 
XP

Windows 
2003 

Server

Windows
Vista

MS-IME 2000 imejp.ime X

MS-IME 2002 imejp81.ime X X

MS-IME 2003 imejp9.ime X X X

MS-IME

(10.0.6000.0)

N/A X

Description File Name Windows 
2000

Windows 
XP

Windows 
2003 

Server

Windows 
Vista

IME 2000 imekr61.ime X X

MS-IME 2002 imekr.ime X X

MS-IME 2003 imekr70.ime X X X

MS-IME

(8.0.6000.0)

N/A X

Description File Name Windows 
2000

Windows 
XP

Windows 
2003 

Server

Windows 
Vista

MS-PinYin 98 pintlgnt.ime X

MS-PinYin 3.0 pintlgnt.ime X X

MS-PinYin 2003 imsc40a.ime X X X

MS-Pinyin IME

(10.0.6000.0)

N/A X
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Traditional Chinese 
Input System:

Notes: IMEs not listed above are not supported. 
 
Text Services FrameWork (TSF) and the Rich Edit control (version 4.1 
and above) are not supported for recording. This does not affect 
playback.

Installing TestPartner 
This section explains the installation process for TestPartner. Please 
review “System Requirements” on page 13 to ensure that TestPartner 
installs and operates properly on your computer.

Before proceeding with the TestPartner installation, Compuware recom-
mends that you review the TestPartner Release Notes which includes 
information about new features, technical notes, and known issues. The 
Release Notes also document recent changes that might not be included 
in TestPartner documentation. Please review this information carefully; 
the Release Notes document is updated as new product information 
becomes available. To review the Release Notes prior to installation, see 
the “Before Installation” section of the “Getting Started” chapter.

Required: Compuware recommends that you exit all non-essential Windows 
programs before running this setup program. Some Windows 
programs may interfere with the installation process. 
 
If you have a TestPartner release prior to 5.6 installed, you must 
back up your data and uninstall TestPartner before installing the 
new version. 
 
You must have administrator permissions to install and use 
TestPartner.

Description File Name Windows 
2000

Windows 
XP

Windows 
2003 

Server

Windows 
Vista

MS-New Phonetic 
IME

tintlgnt.ime X X X

MS-New Phonetic 
IME (10.0.6000.0)

N/A X
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To install TestPartner:

1 From the QACenter installation media, select the TestPartner instal-
lation link. The installation wizard appears.

2 Read the welcome page and click Next. The License Agreement page 
appears. 

3 Read the license agreement. If you consent with the agreement, then 
click Yes. The Customer Information page appears.

4 Type your name and company in the User Name and Company 
Name fields. Click Next. The Choose Destination Location page 
appears.

5 Select a location for the TestPartner installation.

� By default, TestPartner installs in the folder x:\Program Files\Com-
puware\TestPartner where x is the drive where Windows resides on 
your computer.

� To specify a different folder, click the Browse button and select 
the desired folder. Click OK.

6 Click Next. The Select Features page appears. This page allows you to 
select additional features to install. Highlight a feature to view a brief 
description.

7 Select additional features to install:

Note: If you are upgrading a TestPartner release and have previously 
installed any additional features, you must reinstall these features to 
use them with the current release.

� Active Object Recognition: Lets you define support for Java con-
trols that may not be recognized by TestPartner out of the box. 
The Active Object Recognition (AOR) utility includes a collection 
of core Java classes and lets you add custom Helper classes and 
metadata based on your application and requirements. This com-
ponent is typically used by advanced Java users.

� SAP eCATT Integration: Configures TestPartner for proper inte-
gration with SAP’s eCATT testing tool. This allows for storage and 
retrieval of TestPartner data from the eCATT repository and full 
integration for external testing from eCATT.

Note: You must have SAP GUI for Windows 6.20, 6.40, or 7.10 installed to 
enable the eCatt integration feature. For information about configur-
ing SAP for use with TestPartner, refer to the TestPartner Release 
Notes.
Chapter 2� Installing TestPartner     17



� Visual Studio Integration: There are two selections for Visual 
Studio Integration. Microsoft Visual Studio 2005 Team Suite must 
be installed to install these features.
� Visual Studio Team Suite Integration: This option installs 

TestPartner’s integration with Microsoft Visual Studio 2005 
Team Suite. This integration allows you to use TestPartner as 
the testing solution for Visual Studio 2005 test projects. With 
the option installed, you can create TestPartner functional 
test suites, run TestPartner scripts, analyze test runs, and 
launch TestPartner from within Visual Studio 2005. Note that 
if selecting this feature, the Testing Tools subcomponent of 
the Team Developer and Tester Tools component for Visual 
Studio 2005 Team Suite must be installed to install this 
feature.

� Visual Studio Team Test Load Agent Integration: This 
option installs TestPartner’s remote testing integration with 
Visual Studio 2005. This integration allows TestPartner scripts 
to run on remote computers through the Microsoft Visual 
Studio 2005 Team Test Load Agent. Note that the Microsoft 
Visual Studio 2005 Team Test Load Agent and the Visual 
Studio 2005 Team Test Load Controller must be installed on 
the same computer to install this feature.

Note: To start TestPartner functional testing in Visual Studio 2005 Team 
Suite, start Visual Studio 2005 Team Suite after installing TestPartner 
and click Project>Add New Test or Test>New Test. When the Add 
New Test dialog box appears, select the Compuware Functional Test 
template and click OK.

� SQL Server 2005 Express Edition: Installs SQL Server 2005 
Express as the default TestPartner database. This feature is selected 
by default. If you do not want to install SQL Server 2005 Express 
Edition, clear the check box. TestPartner will install Microsoft 
Access 2000 as the default TestPartner database. For additional 
information about SQL Server 2005 Express, see “Setting Up a 
SQL Server Database with TestPartner” on page 24.

Make your selection(s) and click Next. The Start Copying Files page 
appears.

8 If you want to review or change any of your installation settings, 
click Back. Otherwise, click Next. The Setup Status page appears and 
displays an installation progress bar to inform you of the current 
progress of the installation. When the installation completes, the 
InstallShield Wizard Complete page appears.
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9 The Display Release Notes check box is selected by default. Clear 
this check box if you do not want the Release Notes to automatically 
appear. Click Finish to complete the installation of TestPartner. 

Note: After the installation completes, you may be prompted to restart 
your computer.

Where To Go Next

� The evaluation license supplied with your installation of TestPartner 
allows you to install the product and run it for a specific period of 
time without first installing a license. During this trial period, you are 
informed of how much evaluation time remains. 

At any time during the evaluation period, you can obtain and install 
a permanent license. When the evaluation period expires, you must 
obtain a license and install it before you can successfully run this 
product. Refer to the Distributied License Management Installation 
Guide, which you can access from the QACenter installation media, 
for instructions on installing a license.

� TestPartner automatically configures an ODBC data source when 
installed with a SQL Server 2005 Express or Access database. Before 
using TestPartner with other databases, you must create and config-
ure an ODBC data source and an ODBC database. Continue to the 
following sections for instructions:

� “Setting Up a SQL Server Database with TestPartner” on page 24

� “Setting Up an Oracle Database with TestPartner” on page 33

� “Setting Up SQL Server or Oracle for TestPartner Without a 
Domain” on page 45.

Additionally, to use SQL Server 2005 Express in a multi-user environ-

ment, see “Setting Up Users in SQL Server” on page 28.

After you have created and configured your database resources, you are 
ready to begin using TestPartner. Refer to the TestPartner Help for more 
information about the tasks and activities associated with preparing for, 
planning, building, and running test projects.

Performing an Unattended Installation

You can perform an unattended installation of TestPartner, in which 
setup screen entries are made automatically from the command line. An 
unattended installation can be convenient if you want to perform several 
installations of TestPartner with identical configurations on different 
computers from a remote location.
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Note: Software distribution management software, such as Microsoft 
Systems Management Server (SMS), is required to install TestPartner 
remotely.

Unattended Installation Prerequisites

Before performing an unattended installation of TestPartner, you must 
install the following prerequisites on each target installation computer 
(installation commands to run each executable from the QACenter 
installation media are provided after each prerequisite):

Note: Depending on the operating system of the target installation 
computer, some or all of the following installation prerequisites may 
already be installed. 
 
You must install VBA 6.2 even if a later version of VBA is already 
installed. 
 
When using Microsoft Access 2000 as the default TestPartner 
database, VBA 6.2 is the only installation prerequisite. 
 
When installing TestPartner on Windows Vista, you must be logged 
in as an administrator.

� VBA 6.2 (6.0.8714) 
msiexec /i requirements\vba\vba6.msi /q REBOOT=ReallySuppress

� .NET 2.0 Framework 
msiexec /i requirements\dotnetfx.exe /q \c:"install /l /q"

� MDAC 2.8 (2.80.1022.3) 
msiexec /i requirements\mdac_typ.exe /q \c:"dasetup.exe /q /n"

� Windows Installer 3.1 or 4.0 
msiexec /i requirements\WindowsInstaller-KB893803-v2-x86.exe  
/quiet /norestart

Note: To install Windows Installer 3.1, use the above command. Windows 
Installer 4.0 is shipped with Windows Vista. There is no redistribut-
able for installing Windows Installer 4.0 on other operating systems.

� SQL Server 2005 Express with database instance 
msiexec /i requirements\SQLEXPR32.EXE /qn  
ADDLOCAL=SQL_Data_Files INSTANCENAME=QACInst  
SECURITYMODE=SQL SAPWD=qacenter 
SQLBROWSERAUTOSTART=1 DISABLENETWORKPROTOCOLS=2

� SQL Server Management Studio Express (optional) 
msiexec /i requirements\SQLServer2005_SSMSEE.msi /q 
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� SQL Native Client (optional) 
msiexec /i requirements\sqlncli.msi /q REBOOT=ReallySuppress 
APPGUID= {AB5F5371-C53E-47D7-925A-FA792350EF5A}

Unattended Installation Steps

1 Run TestPartner.msi from a command line prompt.

2 Specify the desired installation options and properties.

Note: For a complete list of options and properties, consult the Windows 
Installer SDK documentation. Public properties customized for 
TestPartner installation are listed later in this section.

As an example, the command for an unattended basic installation of 
TestPartner is as follows:

C:\TestPartner\msi>msiexec /i TestPartner.msi /qn

In this example, the display option /qn is used to set the user interface 
level to “none”. The user is never prompted to supply information and 
never sees any messages. In addition to setting the display option, you 
can also set other options, such as whether to restart a computer after 
installation, display a log file, or uninstall a previous TestPartner installa-
tion. To quickly view the standard Windows Installer options, type the 
following from a command line:

C:\>msiexec /help

TestPartner also provides customized public properties that you can use to 
specify additional installation features.
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Customized Public Properties for Unattended Installations

For a listing of these properties, see the following table:

Table 2-1. TestPartner Customized Public Properties for Unattended Installations

Property Description

INSTALLLEVEL Specifies installation features by level. Each feature is 
assigned a value. A feature is installed only if the value 
of the feature is equal or less than the INSTALLLEVEL 
value.

The available TestPartner features and values are:

• Core = 1

• SQL_Server_2k5_Exp_Ed = 50

• Active_Object_Recognition = 150

• SAP_eCATT_Integration = 175

• VSTS_Client_Integration = 200

• VSTS_Remote_Integration = 225

“Core” specifies a base installation of TestPartner with 
Access 2000 installed as the default database.

“SQL_Server_2k5_Exp_Ed” installs a SQL Server 2005 
Express database as the default TestPartner database. 
You must install the SQL Server 2005 Express prereq-
uisites prior to specifying this feature. See “Unat-
tended Installation Prerequisites” on page 20. 

Examples

To install Active Object Recognition, a SQL Server 
2005 Express database, and the base installation 
features:

msiexec /i msi\TestPartner.msi /qn 
INSTALLLEVEL=150

To install all features: 
msiexec /i msi\TestPartner.msi /qn 
INSTALLLEVEL=225
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Unsupported Windows Installer Options

For unattended installations, TestPartner does not support the following 
Windows installer options:

� /a - Administrative installation option: This option installs a prod-
uct on the network.

� /j - Advertising option: This option advertises a product.

� /c - New instance advertising option: This option advertises a new 
instance of a product.

ADDLOCAL Specifies installation features by name. Each feature is 
assigned a name. A feature is installed only if its name 
is specified.

The available TestPartner features listed by name are:

• Core

• Active_Object_Recognition

• SAP_eCATT_Integration

• SQL_Server_2k5_Exp_Ed

• VSTS_Client_Integration

• VSTS_Remote_Integration

“Core” specifies a base installation of TestPartner with 
Access 2000 installed as the default database.

“SQL_Server_2k5_Exp_Ed” installs a SQL Server 2005 
Express database as the default TestPartner database. 
You must install the SQL Server 2005 Express prereq-
uisites prior to specifying this feature. See “Unat-
tended Installation Prerequisites” on page 20.

Examples

To install Active Object Recognition in addition to 
base installation features:

msiexec /i msi\TestPartner.msi /qn 
ADDLOCAL=”Core, Active_Object_Recognition”

To install all features:

msiexec /i msi\TestPartner.msi /qn  
ADDLOCAL=”Core, Active_Object_Recognition, 
SAP_eCATT_Integration, 
VSTS_Client_Integration, 
VSTS_Remote_Integration”

Table 2-1. TestPartner Customized Public Properties for Unattended Installations

Property Description
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Setting Up a SQL Server Database with TestPartner
TestPartner accesses test assets stored in the TestPartner database. This 
section describes how to set up a SQL Server 2005 Express, SQL Server 
2005, and SQL Server 2000 database for use as a TestPartner database.

For SQL Server 2005 Express, the following setup requirements are 
automatically created by the TestPartner installer:

� SQL Server 2005 Express database with instance “QACInst” and 
strong password “qacenter”.

� User with admin rights “TestPartnerAdmin” with strong password 
“TestPartnerAdmin”. General user “TestPartnerUser” with strong 
password “TestPartnerUser”.

� Data source name “TestPartner_SQL”.

� Database schema “TestPartnerDB”.

Note: Compuware recommends that a database administrator or person 
with general knowledge of database administration performs the 
database setup and configuration.

SQL Server Database Connection Requirements

Each client computer uses an ODBC data source to connect to the 
database. As a result, connecting to the TestPartner database has the 
following requirements:

� Each computer running TestPartner must be able to access the com-
puter where the database resides.

� TestPartner must be installed on all computers accessing the data-
base.

� The database connection must be configured for use with TestPart-
ner. See “Configuring a TestPartner Database Connection” on page 
59.

Creating a New SQL Server Database

This section describes how to create a SQL Server 2005 database using 
SQL Server Management Studio and a SQL Server 2000 database using 
SQL Server Enterprise Manager. In addition to the following procedures, 
you must also populate the database with TestPartner tables using the 
Database Maintenance utility, which is described in “Preparing the SQL 
Server TestPartner Database” on page 31. 
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Create a SQL Server database on the server computer by performing the 
following procedures. Separate instructions are provided for both SQL 
Server 2005 and SQL Server 2000.

SQL Server 2005

1 In the Object Explorer of SQL Server Management Studio, right-click 
the Databases folder and choose New Database. The New Database 
window appears.

2 Enter a name for the database in the Database Name field.

3 Click OK.

SQL Server 2000

1 From the SQL Server Enterprise Manager, expand the navigation tree 
until the Databases folder is visible. 

2 Right-click the Databases folder and choose New Database. The 
Database Properties window appears. 

3 In the Database Properties window, enter a name for the database in 
the Name field and click OK.
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Creating a New SQL Server Admin User

You need to create a SQL Server user with system administrator rights to 
perform subsequent setup steps.

Note: For SQL Server 2005 Express, TestPartner automatically creates a 
user with admin rights “TestPartnerAdmin” and strong 
password “TestPartnerAdmin”.

To create a SQL Server admin user:

SQL Server 2005

1 In the Object Explorer of SQL Server Management Studio, navigate to 
the Security folder and expand it. Right-click the Logins icon and 
choose New Login. The New-Login window appears. 

2 In the General page, type a user ID in the Login name field. 

3 Select SQL Server Authentication and enter a password. Select the 
default database from the Default database drop-down list.

4 In the Server Roles page, select sysadmin from the Server roles list.

5 Select the User Mapping page.
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6 In the Map column, select the check box for the database that your 
login can access. By default, the login name appears in the User col-
umn. Leave this value.

7 In the Database role membership for list, select db_owner.

8 Click Ok.

9 In the Object Explorer, right-click the Schema folder and choose New 
Schema. Create a new Schema. The new schema name must match 
the name of the previously created user with system admin rights.

10 Assign the new user with system administrator rights as the owner of 
the schema.

11 Click OK. 

12 Select he newly created user and set the default schema to the newly 
created schema.

SQL Server 2000

1 In SQL Server Enterprise Manager, navigate to the Security folder and 
expand it. Right-click the Logins icon and choose New Login. The 
SQL Server Login Properties dialog box appears. 

2 Select the General page. Enter a user ID in the Name field and select 
SQL Server Authentication.
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3 Click the Server Roles tab. Select System Administrators.

4 Click the Database Access tab. Select your TestPartner database and 
select db_owner in the database roles list that appears below. Click 
OK.

Setting Up Users in SQL Server

The following procedure should be performed on the database server 
computer for each user who needs to connect to the SQL Server database. 

SQL Server 2005 and SQL Server 2005 Express

1 In the Object Explorer of SQL Server Management Studio, navigate to 
the Security folder and expand it. Right-click the Logins icon and 
choose New Login. The New-Login window appears.

2 Select the General page. Enter a user ID in the Login name field. 
Select either Windows Authentication or SQL Server Authentica-
tion.

3 Select the default database from the Default database drop-down 
list.

4 Select the User Mapping page.
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5 In the Map column, select the check box for the database that your 
login can access. By default, the login name appears in the User col-
umn. Leave this value. 

6 In the Default Schema column, enter the default schema. For use 
with TestPartner, the default schema must match the schema of the 
previously created user with system admin rights.

7 In the Database role membership for list, leave the default option 
public selected. Select the db_datareader and db_datawriter check 
boxes.

8 Click OK.

Required: To use SQL Server 2005 Express with multiple users, each SQL 
Server 2005 Express installation must be enabled for remote 
connectivity. To enable SQL Server 2005 Express for remote 
connectivity, refer to the Microsoft support article "How to config-
ure SQL Server 2005 to allow remote connections".

SQL Server 2000

1 Start the SQL Server Enterprise Manager from the Start menu. The 
SQL Server Enterprise Manager Window appears.

2 In the left pane, navigate to the database to which you would like to 
add users. 

3 Click Tools>Wizards... or click the Run a Wizard button on the tool-
bar. This is the button with an image of a wand. The Select Wizard 
dialog box appears:
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4 Click Database and select Create Login Wizard. Click OK. The Cre-
ate Login Wizard dialog box appears.

5 Click Next.

6 Users that are set up in SQL Server can use either Windows NT or SQL 
Server Authentication. 

7 Choose an authentication method:

� To use SQL Server Authentication, select the SQL Server login infor-
mation that was assigned to me by the system administrator (SQL 
Server Authentication) option and click Next. The Authentication 
with SQL Server panel appears.
a In the Login ID field, type the SQL Server login ID for the user 

that will be used to access the SQL Server. This ID is used to 
authenticate the user login credentials to the SQL Server data-
base.

b In the Password field, type the password for the user ID entered 
in the Login ID field. Then retype the user’s password in the Con-
firm Password field. Click Next.

c Click Next. The Grant Access to Security Roles panel appears.

d Click Next. The Grant Access to Databases panel appears.

e Click the appropriate check boxes to select the databases to 
which the user’s account is to have access. Click Next.

f Click Finish.

� To use Windows NT Authentication, select the Windows account 
information I use to logon to my computer (Windows authentica-
tion) option and click Next. The Authentication With Windows 
panel appears.
a Type the domain name and user ID or group name for the user or 

group you would like to add

a Select the Grant access to the server option. Click Next.

b Click Next again.

c Select the check box for the database(s) to which the users will 
have access. Click Next.

d Click Finish.

8 In the left pane, navigate to the database to which you added users 
with the Create Login Wizard. Click Users.

9 In the right pane, right-click the user ID or group you added with the 
wizard in the steps above and choose Properties. The Database User 
Properties dialog box appears.
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10 Select the db_datareader and db_datawriter check boxes. Click OK.

Creating a New Data Source

You must create a new data source to SQL Server from the workstation 
that has TestPartner installed. See “Creating a Data Source Name for a 
SQL Server Database” on page 52 for detailed instructions.

Preparing the SQL Server TestPartner Database

You must prepare your new SQL Server database for use with TestPartner. 
This section describes how to use the Database Maintenance utility to 
populate the database with TestPartner tables.

Required: SQL Server Authentication Mode must be set to: SQL Server and 
Windows (Mixed Mode) to allow connection to the SQL Server 
database through the Database Maintenance utility. This setting 
can be changed after any database maintenance tasks are 
performed.

1 Start TestPartner’s Database Maintenance utility. 

2 Click File>New Database>SQL Server. The SQL Server Data Source 
Connection dialog box appears.

3 Type the name of the new SQL Server data source or click the Browse 
button and select a data source name from the Select ODBC Data 
Source dialog box. Type the name of the database Owner, the SQL 
Server User ID, and Password. Click the Create button.
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Only one schema can be associated with a DSN name (ODBC connec-
tion). If the chosen DSN name is already associated with a schema, a 
Database Maintenance dialog box appears:

4 Click the Replace button to change the association of the DSN name 
from its current schema to the new schema (users will no longer be 
able to access TestPartner tables in the old schema), or click the Alias 
button to create an alias for the DSN name, a DSN Alias Creation dia-
log box appears:

5 Type an alias name for the DSN, this alias will be associated with the 
current schema. Click OK.

The Data Source Creation Status dialog box appears and displays the 
progress of the database creation.

Log on to TestPartner

To test your setup, start TestPartner and log on. See “Logging On and 
Starting TestPartner” on page 58 for instructions.
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Setting Up an Oracle Database with TestPartner
This section describes how to set up an Oracle database with TestPartner. 

Note: The following instructions assume familiarity with the Oracle 
database management system. Compuware recommends that a 
database administrator or a person with general knowledge of 
database administration performs database setup and configuration.

Oracle Database Connection Requirements

Each client computer requires an ODBC data source to connect to the 
database. As a result, connecting to an Oracle database for TestPartner has 
the following requirements:

� Each computer running TestPartner must be able to access the com-
puter where the database resides.

� TestPartner must be installed on all computers that access the data-
base. 

� The appropriate database client connectivity software must be 
installed on any computer that runs TestPartner.

� The database connection must be configured for use with TestPart-
ner. See “Configuring a TestPartner Database Connection” on page 
59.

Selecting an Authentication Method

TestPartner supports the use of either Oracle OS authentication 
(Windows NT) or Oracle database authentication. There are additional 
installation procedures required when using Oracle OS authentication. 
For a complete list of installation procedures required when using either 
authentication method, refer to the appropriate subsection below.

Oracle OS Authentication

1 “Creating a New Oracle Database” on page 34

2 “Setting Up Oracle OS Authentication” on page 34

3 “Setting Up the Oracle Client” on page 35

4 “Preparing the Oracle Database for Client Connectivity” on page 36

5 “Setting Up Users for TestPartner in Oracle” on page 39

6 “Creating the Password Authenticated Schema” on page 42

7 “Creating a New Data Source” on page 43
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8 “Creating the Oracle TestPartner Database” on page 43

Oracle Database Authentication

1 “Creating a New Oracle Database” on page 34

2 “Setting Up the Oracle Client” on page 35

3 “Setting Up Users for TestPartner in Oracle” on page 39

4 “Creating the Password Authenticated Schema” on page 42

5 “Creating a New Data Source” on page 43

6 “Creating the Oracle TestPartner Database” on page 43

Creating a New Oracle Database

Create a new Oracle database with character set UTF8 (and National 
Character Set UTF8 for Oracle 8i). Consult your Oracle documentation if 
creating an Oracle database is unfamiliar.

Setting Up Oracle OS Authentication
Note: This procedure is only necessary if using Oracle OS authentication. If 

using Oracle database authentication, see “Setting Up the Oracle 
Client” on page 35. 

On the server where the database is located:

1 Locate the Oracle Initialization file in the directory where Oracle was 
installed.

2 In the Oracle Initialization file, set values for the following parame-
ters:

Note: If any of these parameters and values do not exist, add them.

remote_login_passwordfile = none

remote_os_authent = true

os_authent_prefix = ““

3 Locate the SQLNET.ORA file in the directory where Oracle was installed. 
The file should be located in ORACLE_HOME\Network\Admin directory 
under the main Oracle installation directory where ORACLE_HOME is the 
name assigned for the Oracle home during installation.

4 Open SQLNET.ORA and set the value of the following parameter to (NTS):

Note: If this parameter does not exist, add it.

sqlnet.authentication_services = (NTS)
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Required: Ensure this parameter is not commented out with a # at the begin-
ning of the line.

5 Access the Run dialog box from the Start menu.

6 In the Open field, type regedit. Click OK. The Registry Editor dialog 
box appears. 

7 In the path HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEn (where n is the 
number associated with the Oracle installation), right-click HOMEn and 
choose New>String Value. A new string value appears in the right 
pane of the registry editor.

8 Replace the default name, New Value #1, with OSAUTH_PREFIX_DOMAIN. 

9 Double-click the string value you just created. The Edit String dialog 
box appears:

10 In the Value data field, type TRUE. Click OK.

Setting Up the Oracle Client

On the client computer from which you will connect:

1 Locate the SQLNET.ORA file in the directory where Oracle was installed. 
The file should be located in ORACLE_HOME\Network\Admin directory 
under the main Oracle installation directory where ORACLE_HOME is the 
name assigned for the Oracle home during installation.

2 Open SQLNET.ORA and set the value of the  
sqlnet.authentication_services as follows:

Note: If this parameter does not exist, add it.

sqlnet.authentication_services = (NTS)

Required: Ensure this parameter is not commented out with a # at the begin-
ning of the line.

3 Open the TNSNAMES.ORA file in the directory where Oracle was installed. 
This file should be located in ORACLE_HOME\Network\Admin directory.
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4 Copy the server’s database entry to the TNSNAMES.ORA file on the client 
computer. For example:

ORACLE_SID.DOMAIN.COM=
(DESCRIPTION=
(ADDRESS_LIST=
(ADDRESS=(PROTOCOL=TCP)(HOST=SERVERNAME)(PORT=1521))
)
(CONNECT_DATA=
(SERVICE_NAME=ORACLE_SID)
)
)

Preparing the Oracle Database for Client Connectivity
Note: This procedure is only necessary if you are using Oracle OS authenti-

cation. If you are using Oracle database authentication, see “Setting 
Up Users for TestPartner in Oracle” on page 39.

Use the following procedure to prepare an Oracle database for client 
connectivity.

Note: This procedure is only necessary if you are using an Oracle client to 
set up the TestPartner database.

Required: You must be logged on using an ID with administrator privileges 
to perform these steps. 
 
You must create users within a Windows NT domain. Refer to your 
Microsoft Windows documentation for more information about 
using a Windows domain. 
 
These procedures are for the Windows XP operating system. To set 
up users in another operating system, consult your Windows 
documentation.

1 On the computer that has User Manager for Domains, access the 
Control Panel.

2 Select Administrative Tools. 
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3 Select Computer Management. The Computer Management utility 
window appears:

4 In the tree view, click Local Users and Groups.

5 Click Groups.

If Oracle is installed, you should see a group named ORA_DBA. If not, 
add it using the following procedure:

Creating the 
ORA_DBA group:

1 In the tree view of the Computer Management utility, right click 
Groups and choose New Group. The New Group dialog box appears. 

2 In the Group Name field, type ORA_DBA. 

3 Click Create.

4 Click Close.

You are now ready to create server access for users.

Creating Server 
Access For Users 

To create individual user accounts:

1 In the tree view of the Computer Management utility, click Local 
Users and Groups.
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2 Click Groups.

3 In the right pane, double click ORA_DBA. The ORA_DBA Properties 
dialog box appears: 
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4 Click the Add button. The Select Users, Computers, or Groups dialog 
box appears:

5 Click Advanced, then use the Common Queries tab to search for 
users, click Find Now and select users from the list.

Or, click in the Enter the object names to select field and type:

domain name\user ID

Where:

domain name: The name of the domain where the user is located.

user ID: The network ID of the user you want to give access to.

6 Click OK to save the user information and return to the ORA_DBA 
Properties dialog box.

7 Repeat step 4–6 to create any additional user accounts. 

8 When you are finished, click OK in the Users Properties dialog box to 
return to the Computer Management utility.

Setting Up Users for TestPartner in Oracle
Note: This procedure is necessary when using either Oracle OS authentica-

tion or Oracle database authentication. Separate instructions are 
provided for each type of authentication. For Oracle OS authentica-
tion, see the subsection immediately after this note. For Oracle 
database authentication see the subsection, “Oracle Database 
Authentication” on page 41.

Oracle OS Authentication

Users must be created in such a way that Oracle knows they are authenti-
cated via a DOMAIN controller. 

Required: When setting up users for TestPartner in Oracle, a schema must be 
also created to house the actual tables in addition to the remotely 
authenticated users. The schema is not domain authenticated, but 
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is password authenticated. See “Creating the Password Authenti-
cated Schema” on page 42 for instructions. 
 
Users must be created within a Windows NT domain. Refer to your 
Microsoft Windows documentation for more information about 
using a Windows domain. 
 
Users must be added to the ORA_DBA group.

Use SQL*Plus or SQL*Plus Worksheet to create users. If you are not famil-
iar with SQL*Plus, consult your Oracle documentation.

The user performing these steps must be a member of the ORA_DBA group 
and have SYSDBA privileges. To specify users that can access the Oracle 
database:

1 Start SQL*Plus or SQL*Plus Worksheet.

2 Log on as SYSTEM and connect as SYSDBA.

3 Type commands to create each user as "DOMAIN\USERNAME" IDENTIFIED 
EXTERNALLY, and grant connection rights for each user as  
"DOMAIN\USERNAME". Type DOMAIN\USERNAME in uppercase and between 
double quotation marks, where DOMAIN\USERNAME is each user’s 
domain and user name. For example:

SQL> create user "NT-DOMAIN\JEFF" IDENTIFIED EXTERNALLY;
SQL> grant connect, resource to "NT-DOMAIN\JEFF";

Note: SELECT_CATALOG_ROLE must also be granted to the user. For 
example:

SQL> grant select_catalog_role to "NT-DOMAIN\JEFF";

Required: Microsoft operating systems return the DOMAIN\USERNAME when the 
user is queried. If this does not match what is defined in the 
database, NT authentication will fail with ORA-1017.

4 Grant rights to access the V_$SESSION view to individual users or to 
all users as a public group. 

Required: All TestPartner users require rights to access the V_$SESSION view. 
To grant these rights, you must be logged on as a user with admin-
istrative rights, e.g., SYSDBA.

When connecting remotely, use the server name or its alias from the 
TNSNAMES.ORA file with the password.

If typing the command to remotely grant access for individual users, 
type DOMAIN\USERNAME in uppercase and between double quotation 
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marks, where DOMAIN\USERNAME is the user name within the domain of 
each user.

The following shows examples of the commands that are typed for 
remotely granting access for individual users, and remotely granting 
access for all users.

Remotely Granting 
Access for Individual 

Users

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO “NT-DOMAIN\JEFF”;

Remotely Granting 
Access for All Users 

(PUBLIC) 

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO PUBLIC;

Note: If you receive any errors that indicate you cannot grant these rights, 
or that the V_$SESSION table cannot be found, you are not logged 
on appropriately.

5 Test that Windows NT authentication is set up correctly by connect-
ing to the database via SQL*Plus. Type a "/" for the user name. Leave 
the Password field blank, and enter the host string appropriately. 
Click OK. If you are able to log on, Windows NT authentication is 
working properly.

Note: In the future, you do not need to create another Oracle TestPartner 
database to add users. You do not have to perform the procedures 
“Creating a New Data Source” and “Creating the Oracle TestPartner 
Database”.

Oracle Database Authentication

Required: When setting up users for TestPartner in Oracle, a schema must 
also be created to house the actual tables in addition to the 
remotely authenticated users. The schema is password authenti-
cated. See “Creating the Password Authenticated Schema” on 
page 42 for instructions.

Use SQL*Plus to create users. If you are not familiar with SQL*Plus, 
consult your Oracle documentation.

The user performing these steps must be a member of the ORA_DBA group 
and have SYSDBA privileges. To specify users that can access the Oracle 
database:

1 Start SQL*Plus or SQL*Plus Worksheet.

2 Log on as SYSTEM and connect as SYSDBA.

3 Type commands to create each user as "USERNAME" IDENTIFIED BY 
“ORACLEPASSWORD”, and grant connection rights for each user as  
Chapter 2� Installing TestPartner     41



"USERNAME". Type USERNAME in uppercase and between double quota-
tion marks, where DOMAIN\USERNAME is each user’s user name. For 
example:

SQL> create user "JEFF" IDENTIFIED BY “ORACLEPASSWORD”;
SQL> grant connect, resource to "JEFF";

Note: SELECT_CATALOG_ROLE must also be granted to the user. For 
example:

SQL> grant select_catalog_role to "JEFF";

4 Grant rights to access the V_$SESSION view to individual users or to 
all users as a public group. 

Required: All TestPartner users require rights to access the V_$SESSION view. 
To grant these rights, you must be logged on as a user with admin-
istrative rights, e.g., SYSDBA.

When connecting remotely, use the server name or its alias from the 
TNSNAMES.ORA file with the password.

If typing the command to remotely grant access for individual users, 
type USERNAME in uppercase and between double quotation marks, 
where USERNAME is the user name within the domain of each user.

For example, to remotely grant access to individual users:

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO “JEFF”;

To remotely grant access for all users (PUBLIC)

SQL>CONNECT SYSTEM/password@ORACLE_SID.DOMAIN.COM AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO PUBLIC;

Note: If you receive any errors that indicate you cannot grant these rights, 
or that the V_$SESSION table cannot be found, you are not logged 
on appropriately. 
 
In the future, you do not need to create another Oracle TestPartner 
database to add users. You do not have to perform the procedures 
“Creating a New Data Source” and “Creating the Oracle TestPartner 
Database”.

Creating the Password Authenticated Schema

Perform the following steps to set up the password authenticated schema 
into which the TestPartner tables are stored. 

Note: The password authenticated schema should not be more than five 
characters in length because of Oracle character limitations in SQL 
series.
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1 Start SQL*Plus or SQL*Plus Worksheet if it is not started.

2 If you are not properly logged on, log on as SYSTEM and connect as 
SYSDBA.

3 Type commands to create each user as "USERNAME" IDENTIFIED AS 
"ORACLEPASSWORD", and grant connection rights for each user as "USER-
NAME". Type USERNAME in uppercase and between double quotation 
marks, where USERNAME is each user’s user name. For example:

SQL> create user "TOM" IDENTIFIED AS "ORACLEPASSWORD";
SQL> grant connect, resource to "TOM";

Creating a New Data Source

You must create a new data source to Oracle. See “Creating a Data Source 
Name for an Oracle Database” on page 55 for detailed instructions.

Creating the Oracle TestPartner Database

1 Start the TestPartner Database Maintenance utility.

2 Click File>New Database>Oracle. The Oracle Data Source Connec-
tion dialog box appears.

3 Type the name of the new Oracle data source or click the Browse but-
ton and select a data source name from the Select ODBC Data Source 
dialog box. Type a User ID, Password, and a brief description of the 
DSN. The Schema field is filled in automatically with the same infor-
mation as the User ID. Click the Create button.

Note: A table called TP_DSNSCHEMA must exist in the SYSTEM schema. If 
the table does not already exist in the SYSTEM schema, a System 
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Login dialog box appears, requiring the password for SYSTEM. Type 
the password, and click OK. The table is created.

Only one schema can be associated with a particular DSN name 
(ODBC connection). If the chosen DSN name is already associated 
with a schema, a Database Maintenance dialog box appears:

Click the Replace button to change the association of the DSN name 
from its current schema to the new schema (users will no longer be 
able to access TestPartner tables in the old schema), or click the Alias 
button to create an alias for the DSN name. A DSN Alias Creation 
dialog box appears:

Type an alias name for the DSN, this alias will be associated with the 
current schema. Click OK.

The Data Source Creation Status dialog box appears and displays the 
progress of the database creation.

Log on to TestPartner

To test your setup, start TestPartner and log on. See “Logging On and 
Starting TestPartner” on page 58 for instructions.
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Setting Up SQL Server or Oracle for TestPartner Without a 
Domain

Note: This procedure only applies when using Windows NT authentication.

Compuware strongly recommends that you use authentication within a 
domain when setting up an Oracle or SQL Server database with TestPart-
ner. However, if you are not on a domain, it is still possible to set up 
these databases.

Required: To begin, you must create a user on both the client and the server 
computers.

To create a user, follow these procedures:

1 Right-click on My Computer and select Manage. The Computer 
Management utility appears.

2 In the left pane, click Local Users and Groups.
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3 Under Local Users and Groups, right-click the Users folder and 
select New User. The New User dialog box appears:

4 Type a valid user name in the User name field, and the correspond-
ing user’s full name in the Full Name field.

5 Type a valid password in both the Password and Confirm password 
fields. Click the Create button.

6 Repeat these steps on each client computer using the username and 
password.

Setting Up SQL Server for TestPartner without a Domain

To set up SQL Server for TestPartner without a domain:

1 On the server computer, right-click on My Computer and select 
Manage. The Computer Management utility appears.

2 In the tree view, click Local Users and Groups.
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3 Click Groups.

4 In the right pane, double click Users. The Users Properties dialog box 
appears: 
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5 Click the Add button. The Select Users, Computers, or Groups dialog 
box appears.

6 Click Advanced, then use the Common Queries tab to search for 
users, click Find Now and select users from the list.

Or, click in the Enter the object names to select field and type:

[user ID],

where [user ID] is the user you want to give access to.

7 Click OK to save the user information and return to the Users Proper-
ties dialog box.

8 Repeat step 5–7 to create any additional user accounts.

9 When you are finished, click OK in the Users Properties dialog box to 
return to the Computer Management utility.

10 Close the Computer Management utility.

Setting Up Oracle for TestPartner without a Domain

To set up Oracle for TestPartner without a domain, follow the procedures 
for “Creating Server Access For Users” on page 37 with the following 
exceptions:
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Substitute the user name you created under, “Setting Up SQL Server or 
Oracle for TestPartner Without a Domain” on page 45 as shown in step 1 
below:

Figure 2-1. Select Users, Computers, or Groups Dialog Box

1 Click in the Enter the object names to select field (Figure 2-1) and 
type [user name] instead of [domain name]\[user ID] or [domain 
name]\[group name].

In addition, when using SQL*Plus to create users see step 3 on page 40, 
substitute COMPUTERNAME\USERNAME for DOMAIN\USERNAME as shown 
below:

2 Create the user as "[COMPUTERNAME]\USERNAME" IDENTIFIED EXTERNALLY, enter-
ing the COMPUTERNAME\USERNAME in uppercase and between "" like 
the following example:

SQL> create user "FH0002RED\USER1" IDENTIFIED EXTERNALLY;
SQL> grant connect, resource to "FH0002RED\USER1"; 

3 Access the TestPartner Database Maintenance Utility.

4 Grant rights to access the V_$SESSION view to individual users or to 
all users as a public group.

Open Oracle’s SQL*Plus Worksheet. Login as SYSTEM and connect as 
SYSDBA. You can grant the access rights by entering the commands 
shown below.

Required: All TestPartner users require rights to access the V_$SESSION view. 
To grant these rights, you must be logged on as a user with admin-
istrative rights, e.g., SYSDBA.

Granting Access for 
Individual Users

SQL>CONNECT SYSTEM/password AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO “COMPUTER NAME\JEFF”;

Granting Access for All 
Users (PUBLIC) 

SQL>CONNECT SYSTEM/password AS SYSDBA;
SQL>GRANT SELECT ON “V_$SESSION” TO PUBLIC;
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Note: If you receive any errors that indicate you cannot grant these rights, 
or that the V_$SESSION table cannot be found, you are not logged 
on appropriately.
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Creating a Data Source Name
On each computer that is connecting to the TestPartner SQL Server, 
Access, or Oracle database, you must create a data source name (DSN) 
using the ODBC utility if the TestPartner.

Note: This does apply to SQL Server 2005 Express and Access databases 
installed by the TestPartner installer. For these databases, a data 
source name is automatically created.

The ODBC utility can be accessed from the Windows Control Panel.

Required: These procedures are for the Windows 2000 operating system. To 
set up users in another operating system, consult your Windows 
documentation.

Creating a Data Source Name for an Access Database

On each client computer connecting to an Access database, perform the 
following steps to set up a DSN:

1 Access the Control Panel, and then select Administrative 
Tools>Data Sources (ODBC). The ODBC Data Source Administrator 
dialog box appears.

2 Click the System DSN tab, then click the Add button. The Create 
New Data Source dialog box appears: 

This dialog box lists the available ODBC drivers.

3 From the list of drivers, select the Microsoft Access Driver and click 
the Finish button. The ODBC Microsoft Access Setup dialog box 
appears.
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4 In the Data Source Name field, type the data source name. Since this 
name appears as the database name in TestPartner’s logon screen, it is 
recommended you enter a logical name in this field.

5 In the Description field, type a description for the data source. For 
example, Connection to TestPartner Access database.

6 Click the Select button and browse for your Access database.

7 On the ODBC Microsoft Access Setup dialog box, click OK.

8 Click OK on the ODBC Administrator dialog box.

Creating a Data Source Name for a SQL Server Database

On each client computer, perform the following steps to set up a DSN:

1 Access the Control Panel, and then select Administrative 
Tools>Data Sources (ODBC). The ODBC Data Source Administrator 
dialog box appears.

2 Click the System DSN tab, then click the Add button. The Create 
New Data Source dialog box appears:

This dialog box lists the available ODBC drivers.

3 From the list of drivers, select SQL Native Client and click the Finish 
button. The Create a New Data Source to SQL Server dialog box 
appears.

4 In the Name field, enter the data source name. Since this name 
appears as the database name in TestPartner’s logon screen, it is rec-
ommended you enter a logical name in this field.
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5 In the Description field, enter a description for the data source. For 
example, Connection to TestPartner SQL database.

6 In the Server field, enter the server name or select it from the drop-
down list. If you do not know the server name, consult your database 
administrator.

7 Click the Next button. The Create a New Data Source to SQL Server 
dialog box appears.

8 Do one of the following:

� If user(s) using the DSN to access the SQL Server database are con-
necting with native authentication, select the With SQL Server 
authentication using a login ID and password entered by the 
user option. 

Make sure the Connect to SQL Server to obtain the default 
settings for the additional configuration options check box is 
selected.

Type the users native SQL Server logon credentials in the Login 
ID and Password fields.

or

� If user(s) using the DSN to access the SQL Server database are con-
necting with non-native credentials, select the With Windows 
NT authentication using the network login ID option.

9 Click the Client Configuration button. The Add Network Library 
Configuration dialog box appears: 

Ensure that the appropriate network library protocol is selected. If 
necessary, consult your network administrator to verify the correct 
network protocol.
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10 Click OK to exit. You are returned to the Create a New Data Source to 
SQL Server dialog box.

11 Click Next.

12 Select the Change the default database to check box, then select 
your TestPartner database name from the drop-down list.

13 Accept all the other entries and click the Next button until the last 
panel in the wizard appears.

14 Accept the defaults and click the Finish button. The ODBC Microsoft 
SQL Server Setup window appears.

Testing the Connection

Once the connection to the database is established, use the following 
procedure to test the connection:

1 In the ODBC Microsoft SQL Server Setup window, click the Test Data 
Source button. You should see the following:

2 Click OK. The ODBC Microsoft SQL Server Setup window displays.

Note: If your test results fail, you need to check your setup steps again.

3 Click OK. The ODBC Data Source Administrator window displays. 
The newly created data source appears in the System Data Sources 
list.

4 Click OK to close the ODBC utility.
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Creating a Data Source Name for an Oracle Database

On each client computer connecting to an Oracle database, perform the 
following steps to set up a DSN:

1 Access the Control Panel, and then select Administrative 
Tools>Data Sources (ODBC). The ODBC Data Source Administrator 
dialog box appears.

2 Click the System DSN tab, then click the Add button. The Create 
New Data Source dialog box appears:

3 From the list of drivers, select the appropriate Oracle ODBC driver for 
the version of Oracle database being used (not the Microsoft ODBC 
for Oracle driver) and click the Finish button. 

The Oracle ODBC Driver Configuration dialog box appears. The 
following shows the dialog box for Oracle 10.2.0.

4 In the Data Source Name field, type the data source name. Since this 
name appears as the database name in TestPartner’s logon screen, it is 
recommended you enter a logical name in this field.

5 In the Description field, type a description for the data source. For 
example, Connection to TestPartner Oracle database.

6 In the TNS Service Name field, select the service name for the data-
base you would like to connect to in the format ORACLE_SID.DOMAIN, 
where ORACLE_SID is the Oracle SID you assigned to the database upon 
creation and domain is the domain that you are connecting to.
Chapter 2� Installing TestPartner     55



7 If using Oracle authentication, type a valid user ID for the database 
being connected to in the User ID field. Otherwise, leave the User ID 
field blank.

8 Test the connection. See “Testing the Connection” below. Otherwise, 
click OK.

Testing the Connection

1 On the Oracle ODBC Driver Configuration dialog box, click the Test 
Connection button.

Note: When using Oracle database authentication, type a username, and 
then a password. For Oracle OS authentication, do not specify a 
username.

A message box appears stating the connection was successful.

2 Click OK to close the message box. The Data Source name creation is 
complete.
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Migrating TestPartner Objects from a Standard Character Set to 
UTF8 (for Unicode)

Compuware recommends that an Oracle DBA or someone familiar with 
Oracle export and import utilities perform the following task. For 
databases larger than 2GB, the DBA should select appropriate parameters 
based on the size of the database.

Oracle databases for TestPartner releases 05.03 and later require a UTF8 
character set. In order to support a TestPartner database previously created 
in an Oracle instance with a standard character set, the database must be 
exported from the standard database and imported into an Oracle 
instance created with a UTF8 character set.

Caution: If the schema from which the TestPartner objects are being 
exported contains more than just TestPartner objects, it is recommended 
(required if the schema is SYSTEM) that the TestPartner objects be transferred 
to a new schema using the TestPartner Database Maintenance Utility 
05.02.00 (or older) Oracle-to-Oracle Copy Utility. The objects can be then 
exported from the new schema.

To perform the migration:

1 Start a command prompt and change the directory to $ORACLE_HOME/
bin. This directory should contain both exp.exe and imp.exe. Exp.exe 
will be used to perform the export, imp.exe will be used to perform 
the import.

Caution: Before exporting, be sure there is sufficient disk space. If there 
is not enough space, export will end in a write failure.

2 Type SET ORACLE_SID=MYSID into the command prompt, where MYSID 
is the SID of the Oracle instance, and press Enter.

3 Type EXP USERNAME/PASSWORD FILE=EXPORT.DMP LOG=EXPORT.LOG CON-
SISTENT=Y into the command prompt, where USERNAME is the name 
of the schema to export and PASSWORD is the password for the 
schema. Press Enter to start the export.

Note: To perform the export without knowing the user’s password, instead 
execute it as the system user. Type EXP SYSTEM/PASSWORD 
FILE=EXPORT.DMP LOG=EXPORT.LOG CONSISTENT=Y OWNER=USER1 into 
the command prompt, where PASSWORD in the system user 
password and USER1 is the owner of the schema to export.

4 Create a new Oracle database with character set UTF8 (and National 
Character Set UTF8 for Oracle 8i). Consult your Oracle documenta-
tion if creating an Oracle database is unfamiliar.
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5 Create a new user in the new Oracle instance and grant them CON-
NECT, RESOURCE, and SELECT_CATALOG_ROLES privileges.

6 Start the TestPartner Database Maintenance Utility.

7 Click Tools>Create UTF8 Migration Database, the Oracle Data 
source Connection dialog displays.

8 Browse to the new Oracle instance with the UTF8 character set for 
the Oracle Data Source Name field and fill in the User ID and Pass-
word fields with the new schema (the Description field is optional). 
Click OK (steps identical to the steps in Creating the Oracle TestPart-
ner Database may have to be followed in order to complete this step).

9 Return to the command prompt and type SET ORACLE_SID=MYSID, 
where MYSID is the SID of the UTF8 Oracle instance, and press Enter.

10 Type IMP USERNAME/PASSWORD FILE=EXPORT.DMP LOG=IMPORT.LOG 
IGNORE=Y into the command prompt, where USERNAME is the name 
of the schema to import into and PASSWORD is the password for the 
schema. Press Enter to start the import.

Note: To perform the import without knowing the user’s password, instead 
execute it as the system user. Type IMP SYSTEM/PASSWORD 
FILE=EXPORT.DMP LOG=IMPORT.LOG FROMUSER=USER1 TOUSER=USER1 
IGNORE=Y into the command prompt, where PASSWORD in the 
system user password and USER1 is the owner of the schema that 
was exported and FROMUSER and TOUSER are identical.

Logging On and Starting TestPartner
Use the following procedure to launch TestPartner and log on to TestPart-
ner.

1 Select TestPartner from the Start menu. The TestPartner splash screen 
appears, followed by the TestPartner Logon dialog box.

2 Type a user name in the User Name field and type a password in the 
Password field.

If using TestPartner for the first time, an administrative user name 
and password may be required. The default user name is Admin and 
the default password is admin. Change this password after logon to 
prevent unauthorized access. 

Tip: You can click 
Tools>Change Password 
to change your own 
TestPartner logon 
password at any time.

3 Select the TestPartner database to work with from the Database list. 
 
If a database does not appear in the Database list, you must config-
ure its database connection for use with TestPartner. To configure a 
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database connection, click the Configure buttonTestPartner. See 
“Configuring a TestPartner Database Connection” on page 59.

4 Click OK. The TestPartner Start Screen appears.

Configuring a TestPartner Database Connection

Before you can use a database with TestPartner, its database connection 
must be configured. The configuration process consists of using the 
Configure Data Source dialog box to perform the following tasks:

� Specify the database connection data

� Verify the connection to the database

� Save the database connection data

All configured database connections appear in the Database list on the 
TestPartner Logon dialog box. 

You can also use the Configure Data Source dialog box to view, edit, and 
remove any existing configured database connections. 
 
Use the following procedure to configure a TestPartner database connec-
tion.

1 Click the Configure button on the TestPartner Logon dialog box. 
The Configure Database Connection dialog box appears.

Figure 2-2. TestPartner’s Configure Database Connection Dialog Box
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2 In the Data Source Type field, select the type of data source.

3 From the Select Data Source list, select from the list of available 
DSNs.

4 Select the Use as a TestPartner database check box to add the 
selected DSN to the list of configured database connections that 
appear in the Database list on TestPartner Logon dialog box. You 
must select this check box when configuring a database connection 
for the first time.

Note: For existing configured database connections, clearing the Use as a 
TestPartner database check box and clicking the Apply button 
removes the selected DSN from the Database list on the TestPartner 
Logon dialog box. TestPartner does not retain the associated 
database connection data.

5 Under Database Settings, specify the appropriate information for the 
selected DSN. The Database/Server and Owner/Schema fields func-
tion differently depending on the selected data source type.

a For Access, the Database field is read-only and displays the loca-
tion of the database file. This value is read directly from the 
ODBC DSN. The other Database Settings fields are not applica-
ble for Access and are disabled. 

b For Oracle, the Server field is read-only and displays only the 
database name. This value is read directly from the ODBC DSN. 
In the Schema field, type the appropriate value.

c For SQL Server, the Database field is modifiable and allows you 
to type the appropriate database name. In the Owner field, type 
the appropriate value.

6 The Authentication field determines the method of authentication 
being used and only applies to Oracle or SQL Server databases. You 
can choose to either use Windows NT authentication or authenticate 
using the database’s native authentication capabilities. When select-
ing database authentication, you must provide the user name and 
password in the appropriate fields.

7 Click Validate to verify that you can connect to the database using 
the specified database connection data.

8 Click Apply to save the database connection data.

9 Click Close.
60     TestPartner Installation and Configuration Guide



Chapter 3

Maintaining the Installation
� Accessing Maintenance Mode

� Modifying an Installation

� Repairing an Installation

� Removing a Product

Accessing Maintenance Mode

Required: Compuware recommends that you exit all non-essential Windows 
programs before running this setup program. Some Windows 
programs may interfere with the installation process.

To access Maintenance Mode from the Windows Control Panel:

1 Click the Windows Start button and choose Settings>Control Panel. 
The Control Panel window appears.

2 Click the Add/Remove Programs icon. The Add/Remove Programs 
dialog box appears. Select Compuware TestPartner and click the 
Change button. The TestPartner installation wizard appears and dis-
plays the Welcome page.

3 Click Next. The Program Maintenance page appears.

From this page of the wizard, you can access the three maintenance 
mode options: Modify, Repair, and Remove. For more information 
about these options, see the appropriate section in this chapter.“Modify-
ing an Installation” on page 62
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Modifying an Installation
Rather than uninstall and re-install the product, you can modify a 
TestPartner installation by adding or removing an optional component.

Modifying Products With Optional Components

1 Access maintenance mode using the method described at the begin-
ning of this chapter.

2 Select the Modify option. Click Next. The Select Components dialog 
box appears allowing you to add or remove components.

3 Click Next. Setup adds or removes the appropriate components.

4 After modifying, you may be prompted to restart your computer. If 
you are prompted to restart your computer, you can choose to restart 
it now (recommended) or to restart it later.

5 Click Finish to complete the maintenance.

Repairing an Installation
There may be times when you need to repair a damaged TestPartner 
installation. This could be due to an inadvertent deletion or corruption 
of the program. To repair a TestPartner installation:

1 Access maintenance mode using the method described in “Accessing 
Maintenance Mode” at the beginning of this chapter.

2 Select the Repair option. Click Next. Setup repairs the TestPartner 
installation. 

3 After repairing, you may be prompted to restart your computer. If 
you are prompted to restart the computer, you can choose to restart it 
now (recommended) or to restart it later.

4 Click Finish to complete the maintenance.

Removing a Product
If you want to remove a TestPartner installation from your computer, 
follow these steps:
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1 Access maintenance mode using the method described at the begin-
ning of this chapter. 

2 Select the Remove option. Click Next. The Remove the Program 
page appears. 

3 Click Remove. Setup removes the TestPartner installation, but does 
not delete the TestPartner database.

4 After uninstalling, you may be prompted to restart your computer. If 
you are prompted to restart your computer, you may choose to restart 
it now (recommended) or to restart it later.

5 Click Finish to complete the maintenance.
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